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SunPCi™ 1.3
Read Me First

The SunPCi™ 1.3 software runs on the Solaris™ 2.6, Solaris 7, and Solaris 8

operating environments.

This document discusses the following topics:

■ What Is In This Package?

■ Installing the SunPCi Package

■ Updating the BIOS

■ Creating a New Windows 2000 Installation

■ Upgrading from Windows NT to Windows 2000

■ What Are the Known Problems With This Release?

Note – If you have a previous version of the SunPCi software installed, remove the

existing package and install a complete new package. If you are installing the

SunPCi software for the first time, simply install the package.

What Is In This Package?

The SunPCi 1.3 installation package contains the following files:

■ SunPCi 1.3 software package (SUNWspci)
■ SunPCi 1.3 Read Me First (this document)
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Installing the SunPCi Package

This section describes how to install the full package of the SunPCi 1.3 software.

This version does not contain an upgrade patch for previous versions of SunPCi. The

SunPCi software is no longer distributed in patch form.

If you are upgrading from a previously installed version of the SunPCi software, you

need to remove the previous version and install the full SunPCi 1.3 package. To

remove the old package and install the new package, follow the procedures in this

section.

If you are installing SunPCi software for the first time, skip the following section and

proceed to “Installing the SunPCi 1.3 Package” on page 5.

Removing the Previous SunPCi Package

You will need to remove any previously installed versions of the SunPCi software

before you can install this package.

The pkgrm program removes the old SunPCi program files. To run pkgrm , perform

the following procedure.

1. Become superuser on your system.

Enter the following command:

Enter the root password. The superuser prompt (for example, #) appears. If you do

not know the password, see your system administrator.

2. Enter the following command:

You are prompted to confirm the removal process.

% su

# /usr/sbin/pkgrm SUNWspci
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3. Enter y to continue with the removal, and then type y again to confirm.

The SunPC package is removed from your system. You are notified when the

removal is complete. The system responds with the following message:

You can now proceed to the next section.

Installing the SunPCi 1.3 Package

Follow this procedure if you are installing SunPCi software for the first time, or if

you have removed the previous version of the software in the previous section. If

you do not already have the SunPCi card installed in your system, refer to the

SunPCi Installation Guide for instructions on how to install the hardware.

To install the SunPCi 1.3 package, perform the following procedure.

1. Open a command (terminal) window on the Solaris desktop.

2. Become superuser on the system on which you want to install the SunPCi
package.

3. Start the pkgadd program. Type the following command:

where pathname is the path to the SunPCi package; for example, /home/joeuser/
temp .

The pkgadd program starts, and displays the following message:

Removal of <SUNWspci> was successful.

# /usr/sbin/pkgadd -d pathname

The following packages are available:
1 SUNWspci SunPCi

(sparc) 1.3
Select package(s) you wish to process (or 'all' to process all
packages). (default: all) [?,??,q]:
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4. Press Return to accept the default choice (install the SunPCi package), and then
press y to continue.

The pkgadd program copies the SunPCi files to the /opt directory on your system.

The files are listed on your screen as they are copied. When all the SunPCi files have

been copied, pkgadd displays the following message:

5. Enter q to exit the pkgadd program.

Note – If the pkgadd program issues a BIOS Mismatch message, you will need to

flash (update) the BIOS on your SunPCi card. Refer to the following section for

information on how to use the sunpciflash utility.

6. Type the exit command to end your superuser session.

You are returned to your normal user session.

Updating the BIOS
You need not update the BIOS on your SunPCi card unless you are running a

version lower than .059, or if the pkgadd program issues a BIOS Mismatch
message.

To update the BIOS, refer to the SunPCi Installation Guide. Your BIOS version should

be .059 or later in order to run the Windows 2000 operating system.

Creating a New Windows 2000
Installation

SunPCi 1.3 supports Windows 2000 Professional. There are two ways to install

Windows 2000 on your SunPCi software:

Installation of SUNWspci was successful.
The following packages are available:
1 SUNWspci SunPCi

(sparc) 1.3
Select package(s) you wish to process (or 'all' to process all
packages). (default: all) [?,??,q]:
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1. Create a new emulated hard disk and install Windows 2000 and all of your

Windows-based applications. This section discusses how to perform this

procedure.

2. Upgrade your Windows NT emulated disk to Windows 2000. This method

preserves all of the applications and data you installed on your Windows NT

emulated drive.

The procedure in this section describes how to install Windows 2000 to a newly

created C: drive. For information on how to upgrade an existing Windows NT

emulated drive, refer to “Upgrading from Windows NT to Windows 2000” on

page 11.

Note – This release does not support upgrading from Windows 98 to Windows

2000.

Note – It is strongly recommended that you upgrade your SunPCi card to at least

128 Mbytes of RAM before installing and running Windows 2000.

Before You Start

Make sure you have the following available before you start installing Windows

2000:

■ Windows 2000 Professional CD-ROM

■ The system name for your SunPCi card on your network and the workgroup

name for your Windows NT installation on SunPCi

■ Enough available space in your home directory or on your local host to contain an

emulated drive of at least 2 Gbytes

Note – Follow the installation procedures in this manual, even if you have installed

Windows 2000 on a PC before. The setup and configuration procedures for the

SunPCi 1.3 program involve some different steps.
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Installing Windows 2000

Note – The Windows 2000 installation process can take longer to complete than

Windows NT installation.

To install Windows 2000 on your SunPCi system, you create a new C: drive and

install Windows 2000 to it. For best results, create your SunPCi C: drive on a local

hard disk on your workstation, rather than in your home directory. Installing

Windows takes much less time on a local drive, and performance is significantly

better.

To install Windows 2000 on your SunPCi system, either on your local disk or in your

home directory, create a new C: drive and install Windows 2000 on it.

When you want to run SunPCi with Windows 98 or Windows NT, create another

emulated C: drive. Use the Attach Hard Disk command under the Options menu to

select the C: drive file with Windows 98 or Windows NT on it, and then reset

SunPCi.

If you want to run Windows 2000, use Attach Hard Disk to select the C: drive with

Windows 2000 installed, and then reset SunPCi.

Creating a New C: Drive

To install Windows 2000 on a new C: drive, follow this procedure. If you do not

already have the SunPCi software running, start SunPCi first.

Note – Make sure that the emulated drive you create is at least 2 Gbytes in size.

Windows 2000 requires approximately 1.7 Gbytes of hard disk space.

Caution – Do not use the Windows 2000 boot diskettes to install Windows 2000 on

SunPCi software. You must perform the procedure outlined in this chapter to ensure

that the correct drivers are installed.

1. From the Options menu in the SunPCi window, select Create a Hard Drive.

Create the drive as drive C:. For more information about how to create a new drive,

refer to Chapter 3 of the SunPCi User’s Guide.
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2. Click OK when the dialog box asks you to reboot SunPCi.

The SunPCi software reboots. The DOS prompt (C:\> ) is displayed.

3. Make sure your Windows 2000 CD is in the CD-ROM drive.

4. If you are using Solaris Volume Manager (vold ) to control your CD-ROM drive,
type the following command:

If you are not using Solaris Volume Manager, type this command instead,

substituting the location of the Windows 2000 files for path:

The default location for the Windows 2000 files is R:\cdrom\cdrom0\i386 .

However, if your Windows 2000 files reside at a different location other than the

default CD-ROM, you need to use the /s: switch to specify where the files are

located. For example, if your Windows 2000 disk image is located in your Solaris

directory at /export/home/winnt/i386 , you would type the following command

all on one line:

The setup process takes a few minutes to complete. SunPCi software responds with

the following messages:

When the setupw2k script finishes copying the Windows 2000 files to your C: drive,

it reboots the SunPCi software. The Windows 2000 Setup screen is displayed. When

Windows 2000 Setup has finished copying files, it reboots the SunPCi software

again.

C:\> f:\drivers\win2k\setupw2k

C:\> f:\drivers\win2k\setupw2k /s:\ path

C:\> f:\drivers\win2k\setupw2k /s:r:\export\home\win2k\i386

Copying Windows Setup files...

Copying Windows Boot files...

Copying Windows System files...

Copying Optional files...

Copying SunPCi Installation files...
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Note – Your mouse may not be active during the following installation process. Use

the Tab key and the arrow keys to navigate the Windows 2000 setup screens.

5. Click Agree when the Windows 2000 License Agreement is displayed.

The Copying Files message appears.

6. Type your name and organization into the dialog box and click Next.

The CD Key dialog box appears.

7. Type the CD key from the back of your Windows 2000 Workstation CD-ROM
envelope. When you have finished, click Next.

The Workstation Name dialog box is displayed.

8. Type the name of your SunPCi system on the network and click Next.

9. Type your administration password in the dialog box, and then type it again to
confirm that this is the password you want to use. When you have finished, click
Next.

The Windows 2000 Networking Setup dialog box is displayed.

10. Click Next to continue.

The following message is displayed:

As the setup script sets up Windows 2000 installation, a progress bar appears.

When the setup process is complete, the following message is displayed:

The Saving Configuration screen appears with a progress bar. When the process is

complete, the SunPCi software reboots.

11. When the OS Loader message appears on the Windows 2000 screen, press Return
or wait 30 seconds for Windows 2000 Workstation to load.

The Windows 2000 login screen is displayed with the following message:

Setup is preparing to initialize Windows 2000 installation

Setup is configuring your workstation to use Windows 2000

Press Ctrl+Alt+Del to log in
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When you log in for the first time, Windows 2000 executes some additional

commands before completing the installation. When these commands are complete,

the Windows 2000 desktop is displayed. Windows 2000 defaults to an Administrator

login with no password.

Note – Your mouse will not be active until after you log in to Windows 2000.

Upgrading from Windows NT to
Windows 2000

This section explains how to update an existing emulated drive file from Windows

NT Workstation 4.0 to Windows 2000. Perform this procedure if you want to keep

your existing application links and environment with Windows 2000.

Note – This release does not support upgrading from Windows 98 to Windows

2000.

Before You Start

Before you install Windows 2000, make sure you have the latest release of SunPCi

software installed and that the latest drivers are installed. If you have not already

performed the procedures in “Installing the SunPCi 1.3 Package” on page 5, do so

before installing Windows 2000.

Make sure you have the following available before you start installing Windows

2000:

■ Windows 2000 Professional CD; the installation will not work without the CD in

your CD-ROM drive

■ Enough available free space in your C: drive (at least 1.7 Gbytes)

Note – Before you perform the upgrade, it is strongly recommended that you make

a backup copy of your C: drive file.
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▼ To Update the SunPCi Drivers

Before you can upgrade your Windows NT installation to Windows 2000, you need

to update the SunPCi drivers. Follow the steps outlined in this section.

Note – This procedure updates the SunPCi Windows NT drivers to run with

Windows 2000. It does not upgrade your Windows NT installation to Windows 2000.

The upgrade procedure is outlined in the next section, “To Perform the Upgrade” on

page 12.

1. Click on the Start button, and then choose Programs and Windows NT Explorer.

The Windows NT Explorer window is displayed.

2. From the Tools menu, select Map Network Drive.

The Map Network Drive dialog box is displayed.

3. Map a network drive (for example, X:) to the following path:

The updatedrv program appears in the list of files.

4. Double-click on updatedrv to update the Windows NT drivers to Windows 2000.

5. When the upgrade process is finished, reboot Windows.

▼ To Perform the Upgrade

This procedure updates the SunPCi Windows NT installation to Windows 2000.

Caution – Follow the instructions in this section carefully to perform the upgrade.

Do not use the standard Microsoft upgrade procedure provided on the Windows

2000 Professional CD. If you do use the standard upgrade procedure, the installation

will fail, and your emulated C: drive may become corrupted.

Note – Follow the installation procedures in this manual, even if you have installed

Windows 2000 on a PC before. The setup and configuration procedures for the

SunPCi 1.3 program involve some different steps. If you do not follow these

procedures and you install directly from the Windows 2000 CD, your Windows 2000

emulated disk will not run with SunPCi.

\\localhost\opt\SUNWspci\drivers\winnt\patch
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1. Insert the Windows 2000 Professional CD into your workstation’s CD-ROM drive.

2. Click on the Start button, and then choose Programs and Windows NT Explorer.

The Windows NT Explorer window is displayed.

3. Navigate the Windows NT Explorer window to the following path:

Note – If you cannot find this directory on your C: drive, either you have installed

the wrong version of the SunPCi software, or you did not update your SunPCi

drivers. To check your version of SunPCi, use the Help menu. To update the drivers,

refer to “To Update the SunPCi Drivers” on page 12.

4. Open the folder and double-click on upgrade .

The upgrade process continues. This program automatically maps a network drive

for its own use. If you do not have a network drive letter available in Windows

Explorer, the process fails.

Note – If you do not have the Windows 2000 CD in your CD-ROM drive, the

upgrade process fails at this step.

The upgrade process continues. When it has finished, it reboots. After the reboot

processes are complete, the Windows 2000 upgrade screens are displayed with the

following prompt:

Caution – At this point, you may either install Windows 2000 to your Windows NT

directory, or you may choose a new directory for Windows 2000. If you choose the

new directory, Windows 2000 will not be able to use your existing applications.

5. Type Y (for Yes) to install Windows 2000 to your Windows NT directory, and then
press Return.

Windows reboots one more time. When it has finished rebooting, the Windows 2000

splash screen is displayed.

C:\w2kupg

Do you want to overwrite your Windows NT directory?
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6. Follow the prompts on the screen and enter the information that Windows
requests (for example, the CD key on the back of your CD case, your
administrator’s password, and so on).

When you have finished entering all the information, the SunPCi software reboots

again into Windows 2000.

Note – This step may take several minutes to complete.

You are now ready to use Windows 2000 with your installed applications.

What Are the Known Problems With
This Release?

This section describes known problems with this release of SunPCi 1.3 software.

These problems will be fixed in subsequent releases. The section includes the

following topics:

■ Mouse Performance

■ Filesystem Drives

■ Application Issues

■ Windows 2000 Specific Issues

■ Troubleshooting

Mouse Performance

The following message may appear in the launch window when you are using

SunPCi:

If this occurs, ignore the message.

The Windows 2000 cursor on this SunPCi board may not work properly
**** WARNING ****
**** WARNING ****
W2KMouseFailover: Using Emergency Cursor
W2KMouseFailover: Failover to using mouse_event
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Filesystem Drives

File attributes (such as read-only and write-only) may not work correctly.

For more information on filesystem drives, refer to the SunPCi User’s Guide.

Application Issues
■ This version of the software does not support dual-boot emulated drives. If you

want to run multiple versions of Windows on SunPCi, create an emulated drive

for each operating system and install the operating system and applications to it.

Use the Attach Drive command under the SunPCi Options menu to switch among

the different operating systems.

■ In 24-bit mode, some applications will show text highlighting as opaque black

boxes over the highlighted text. This is a known problem and is being

investigated.

Windows 2000 Specific Issues

Service Pack 1 Support

SunPCi does not support Service Pack 1 for Windows 2000 at this time.

Multi-Processor Support

This version of SunPCi only supports Windows 2000 Professional.

Creating Large Disk Partitions in Windows 2000

Partition Magic, a third party commercial application by PowerQuest Corporation,

has been tested and qualified to run on SunPCi. Partition Magic allows you to easily

manage space allocation on your C: and D: drives.

If you are using Windows 2000, use Partition Magic for Windows 2000 version 5.01

as described in the following steps. Make sure you have two formatted diskettes

available for this procedure.
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1. Install Partition Magic for Windows 2000, if you have not already done so.

If you have a version of Partition Magic that is earlier than 5.01, make sure you

download and install any necessary upgrade patches before proceeding. In

particular, make sure you have the Partition Magic 5.01 patch for Windows 2000

installed. Running Partition Magic 5.01 creates the two boot diskettes that you need

to execute the program.

2. Use the following command at the Windows 2000 command prompt:

At this command, Partition Magic creates two boot diskettes. You use these diskettes

to run Partition Magic for Windows 2000.

The system responds with the following message:

3. Type yes and then close the Command Prompt window.

4. Restart Windows 2000.

During the restart process, Windows 2000 converts the C: drive to NTFS format.

5. After Windows 2000 has finished restarting, insert the Partition Magic Disk #1
into your workstation’s diskette drive.

6. Restart Windows 2000 again. Follow the on-screen instructions to run the Partition
Magic program.

Note – You may see two mouse cursors on the SunPCi screen while running

Partition Magic from the command prompt. Use the Attach Mouse command on the

Options menu to display only one mouse cursor within the SunPCi window.

C:\> convert C: /fs:ntfs

The type of the file system is FAT. Convert cannot gain exclusive
access to the C: drive, so it cannot convert it now. Would you like
to schedule it to be converted the next time the system restarts?
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CD-ROM Drive Issues

The following are known problems with the CD-ROM drives in Windows 2000:

■ When you insert a CD into your CD-ROM drive, the Autorun feature does not

work. Click the Start button, and then select Run from the pop-up menu. Click the

Browse button and then browse to select the desired Setup file.

■ Other information about your CD may be slow to display, or will not update at

all. This includes the system information about the CD and the title of the CD

when viewed in Windows Explorer.

Mouse Issues

■ The SunPCi mouse (virtual mouse) does not work with the external monitor and

Windows 2000 in this release of SunPCi. This is a known problem and is being

investigated.

■ During installation and when you first log in to Windows 2000, the mouse

appears to be disabled. You will need to use the Tab and arrow keys to navigate

the screens on your Windows desktop. After you have logged in, the mouse

behaves normally. This also occurs when you press Ctrl+Alt+Delete. You will

need to use the keyboard.

Cursor Behavior

You may observe the following behaviors while using the mouse cursor in Windows

2000:

■ When you perform certain window operations (such as resizing the window),

your mouse cursor changes shape (for example, from the pointer arrow to the

diagonal double arrow). Occasionally, the SunPCi cursor does not change shape,

but you will still be able to perform the operation.

■ When you move the cursor off the Windows desktop, you may see a copy of the

cursor remaining on the desktop.

■ Using the Mouse Properties Control Panel to change the cursor shape may not

work.

■ Occasionally, the cursor may disappear from the external display when using a

USB or serial mouse. If this occurs, press Ctrl+Alt+Del to reset the mouse.

■ Workstation display only: When you restart Windows 2000, your cursor may stay

black on the Windows desktop until you log back in. This does not occur when

you use an external display.
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Printer Issues

Occasionally, Windows 2000 may exit and display a “blue screen” when you are

setting up a network printer to work with SunPCi. If this happens, choose Reset

SunPCi from the File menu to restart Windows. Once Windows restarts, you should

be able to set up the printer.

Filesystem Drive Issues

■ Windows 2000 only: File links (such as symbolic links) do not work on filesystem

drives. If you need to link to a file that is located on a filesystem drive, move the

file to your C: or D: drive and then create the link.

■ Windows 2000 Disk Administrator does not function correctly. This is a known

problem and is being investigated.

■ Windows 2000 only: If you create a C: or D: drive that is larger than 2 Gbytes in

size, you need to convert the drive to NTFS or FAT32 in order to be able to use all

of the space on that drive. Refer to “Creating Large Disk Partitions in Windows

2000” on page 15 for the conversion procedure. For more information on the

convert command, refer to your Windows NT or Windows 2000 documentation.
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Troubleshooting

This section lists some possible problems, their causes, and recommended solutions.

TABLE 1 SunPCi Troubleshooting

Problem Cause Solution

Upgrading Windows NT to

Windows 2000 results in a

“blue screen” with the error

message

INACCESSIBLE_BOOT_
DEVICE.

You used the standard

Microsoft upgrade on the

Windows 2000 CD instead

of the recommended

procedure in this document.

Use the backup copy of

your C: drive and perform

the procedure described in

“To Perform the Upgrade”

on page 12.

If you did not create a

backup C: drive, create a

new C: drive and install

Windows 2000 as described

in this document. You will

have to reinstall all of your

applications.

Inserting a file into

Microsoft Office 2000

doesn’t work.

The object file (such as clip

art or an Excel spreadsheet)

is located on a filesystem

drive or on a drive mapped

using \\localhost\ path.

Copy or move the object file

to your C: or D: drive and

then insert it again.

The mouse no longer works

when I click the Start

button. (24-bit displays

only)

There is a software conflict

with the screen fade effect

in the Display control panel.

Turn off the fade effect by

selecting the Display control

panel. Deselect the first

checkbox under visual

effects. Click on OK. The

mouse should work again.

Certain characters in some

fonts or languages are

incorrect, or using them

causes SunPCi II to hang.

The font server needs to be

turned off.

1. Exit SunPCi, if it is

running.

2. Use a text editor to edit

the ~/pc/SunPC.ini file.

3. Add the following lines

to the end of the file:

[Display]
OldText
4. Save the file and exit the

editor.

5. Restart SunPCi.
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	5. Enter q to exit the pkgadd program.
	6. Type the exit command to end your superuser session.


	Updating the BIOS
	Creating a New Windows 2000 Installation
	1. Create a new emulated hard disk and install Windows 2000 and all of your Windows-based applica...
	2. Upgrade your Windows NT emulated disk to Windows 2000. This method preserves all of the applic...
	Before You Start
	Installing Windows 2000
	Creating a New C: Drive
	1. From the Options menu in the SunPCi window, select Create a Hard Drive.
	2. Click OK when the dialog box asks you to reboot SunPCi.
	3. Make sure your Windows 2000 CD is in the CD-ROM drive.
	4. If you are using Solaris Volume Manager (vold) to control your CD-ROM drive, type the followin...
	5. Click Agree when the Windows 2000 License Agreement is displayed.
	6. Type your name and organization into the dialog box and click Next.
	7. Type the CD key from the back of your Windows 2000 Workstation CD-ROM envelope. When you have ...
	8. Type the name of your SunPCi system on the network and click Next.
	9. Type your administration password in the dialog box, and then type it again to confirm that th...
	10. Click Next to continue.
	11. When the OS Loader message appears on the Windows 2000 screen, press Return or wait 30 second...


	Upgrading from Windows NT to Windows 2000
	Before You Start
	To Update the SunPCi Drivers
	1. Click on the Start button, and then choose Programs and Windows NT Explorer.
	2. From the Tools menu, select Map Network Drive.
	3. Map a network drive (for example, X:) to the following path:
	4. Double-click on updatedrv to update the Windows NT drivers to Windows 2000.
	5. When the upgrade process is finished, reboot Windows.

	To Perform the Upgrade
	1. Insert the Windows 2000 Professional CD into your workstation’s CD-ROM drive.
	2. Click on the Start button, and then choose Programs and Windows NT Explorer.
	3. Navigate the Windows NT Explorer window to the following path:
	4. Open the folder and double-click on upgrade.
	5. Type Y (for Yes) to install Windows 2000 to your Windows NT directory, and then press Return.
	6. Follow the prompts on the screen and enter the information that Windows requests (for example,...


	What Are the Known Problems With This Release?
	Mouse Performance
	Filesystem Drives
	Application Issues
	Windows 2000 Specific Issues
	Service Pack 1 Support
	Multi-Processor Support
	Creating Large Disk Partitions in Windows 2000
	1. Install Partition Magic for Windows 2000, if you have not already done so.
	2. Use the following command at the Windows 2000 command prompt:
	3. Type yes and then close the Command Prompt window.
	4. Restart Windows 2000.
	5. After Windows 2000 has finished restarting, insert the Partition Magic Disk #1 into your works...
	6. Restart Windows 2000 again. Follow the on-screen instructions to run the Partition Magic program.
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